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PAPER - 1
Duration : 2 ½ hours

Marks : 80

Note :
(1) In Section I, Part A Question No. 1 is compulsory.
(2) In Section I, attempt any two questions from Question Nos. 2 to 5.
(3) In Section II, attempt any two questions from Question Nos. 6 to 9.
(4) Answers to both Sections should be written in the same answer book.
(5) Figures to the right indicate maximum marks.
SECTION - I (PART - A)
Q1 (a)
(i)
(ii)
(iii)
(iv)
(v)
(vi)
(vii)
(viii)

State whether the following statements are true or false:
An operating system is hardware.
LAN is an operating system.
MS-DOS operating system is a multi-user operating system.
DOS is a Graphic user interface program.
Networking facility is available with Unix operating system.
WAN is an operating system.
Unix is an operating system.
Every computer has its own operating system.

[4]

(b)

Write a short note on Computers Memory.

[2]

(c)
(i)
(ii)
(iii)
(iv)
(v)

Answer the following in ‘C’:
What is the use of main()?
Mention the names of storage classes.
What is the use of escape sequence? Give two examples.
Which are the basic data types in C?
What is the use of continue statement?

[5]

(d) Explain the use of following functions in Foxpro:
(i) RIGHT()
(ii)
SUBSTR()
(iv) MAX()
(v)
MIN()
Q2 (a)
(i)
(ii)
(iii)
(iv)
(v)
(vi)

[5]
(iii)

Answer the following in one or two sentences:
What is the use of RAM?
What is the function of the Control Unit of the CPU?
Mention the components of LAN.
What is the function of Central Processing Unit?
Give one important feature of Unix operating system.
Mention the advantages of LAN.
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(b)

What does the following ‘C’ program print.
#include<stdio.h>
main()
{ int x=6589;
char z=‘*’;
float y=8888.9935;
printf(“%+07d %+08.1f %3c\n”, x,y,z);
printf(“%-+8d %+-4.0f %-3c\n”, x,y,z); }

[2]

(c) Write a program using do-while loop, to find and print the sum of:

[3]

13 2 3 3 3
93
+
+
+ .... +
2
3
4
10
(d) Write a program to input Cost(c) of a machinery and it’s rate of
depreciation(r) and then find and print a table displaying Year and
Depreciation for the first 10 years using reducing balance method. Finally,
print the written down value as scrap value.
Q3 (a)
(i)

Write short notes on the following:
C.P.U.
(ii)
Windows Operating System

[5]
[6]

(iii)

WAN

(b)
(i)
(ii)

Answer the following in ‘C’:
What are type modifiers?
What is the use of pre-processor directive? Give examples.

[2]

(c)

What does the following ‘C’ program print.
#include<stdio.h>
main()
{ int i,j;
for(i=1,j=2;i<10,j<20;i++,j+=3)
{ j+=i;
printf((“%3d%-3d\n”,i,j); } }

[2]

(d) Write a program in ‘C’ to enter 10 observations and then print their mean,
mean deviation from mean, standard deviation and variance, where

∑X
X = n
Q4 (a)
(i)
(b)
(i)

∑|X − X|
n
md =

[6]

∑ | X − X |2
sd =

n

2

v = sd

Mention two differences between the following:
RAM and ROM
(iI)
DOS and UNIX

[4]

Distinguish between:
printf() and puts()

[4]
(ii)
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(iii) putchar() and puts()
(c)

(iv)

while and do-while loops

What does the following ‘C’ program print.
#define f(x) x>20 ? 20 : x*x
main()
{ int p=5,q=6,r=9;
r+=5*p--;
q+=f(p);
printf("%d %d %d\n",p,q,r); }

(d) A wholesaler offers discount on the basis of order amount. The order
amount and discount rate is as follows :
Order Amount (Rs.)
Discount Rate
Upto Rs.10,000
5%
Above Rs.10,000 and Upto Rs.20,000
10%
Above Rs.20,000
15%
Write a program to input Customer name(cn) and order amount(a) and
then print customer name, order amount, discount(d) and net amount(n).
Q5 (a)
(i)

Write short notes on the following:
Unix
(ii)
LAN
(iii)

Operating System

(b)
(i)

Distinguish between:
scanf() and getchar()

getche() and getch()

(c)

What does the following ‘C’ program print.
#define p(a,b) (a+b)/2
main()
{ int x=4, y=9, h;
x+=y++;
y*=3;
h=p(x,y);
printf(“%05d%+5d%-5d\n”,x,y,h);}

[2]

[6]

[6]

[2]
(ii)

(d) Write a program in ‘C’ to input 20 observations and then print these
observations in the ascending order - 5 on each line, also print these
observations in the descending order - 10 on each line. Finally, print the
highest, lowest and median.

[2]

[6]

SECTION - II

Q6 (a)

What are Screen-Savers in Windows’95?

[2]

(b)

Explain the use of Page Setup in Ms-Word?

[2]

(c)
(i)

State whether the following statements are true or false:
In Ms-Word, by default a document is always saved in My Briefcase.

[2]
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(ii)

In Ms-Word, while opening a document, Save As box allows you to select
a folder and search for a file.
(iii) In Ms-Word, Break option is in Edit menu.
(iv) In Ms-Word, Date and Time option appears in Insert Menu.
(d)
(i)

Explain the difference between the following in Foxpro:
LIST and DISPLAY
(ii)
FIND and SEEK

(e) Write Foxpro commands for the following:
(i) To position the record pointer on the first record where NAME field has the
word “PARSHU” in it.
(ii) To make changes in the structure of the currently active table.
(iii) To display those records where NAME field contains the word “PATIL”.
(iv) To mark for deletion the record numbers 10 to 35.
(v) To cancel the deletion of all the records which are marked for deletion.
(vi) To allow only the records which are not marked for deletion to take part in
listings and calculations.

Q7 (a)
(b)

(c)

(d)
(i)

[4]

[6]

What is a icon in Windows’95?

[2]

What is the use of EDIT Menu in Ms-Word and discuss any four options
from this menu.

[2]

Currently you are editing a document in Ms-Word containing 4 pages of
text. In page number 3, you want to enter “AROUND THE WORLD” as
first line of text and then you want to replace the word “WORLD” with
“GLOBE” wherever it appears in the whole document. Explain how to
achieve this.

[2]

Explain the use of the following commands in Foxpro:
BROWSE
(ii)
PACK
(iii)
RECALL

(e) There is a Foxpro table called SALES.dbf containing fields Salesman
number(SNO,Numeric,3), Salesman name(SNAME,Character,20), Total
Sales(TSALES,Numeric,10,2), Area Code (ACOD, Character,10) and
there is another table called DAILYSL.dbf containing fields Salesman
number
(SNO,Numeric,3),Salesdate(SDATE,Date,8),Sales
order(SORD,Numeric,10,2) and Customer name (CNAME,Character,20).
Write commands:
a. To create compound index file for both the tables according to Salesman
number.
b. To set relation between these two files on the basis of field SNO.
c. To display a list showing Salesman number, Name, Sales date, Sales
order and Area code for every record.
d. To update the field TSALES by adding Sales order from the table
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DAILYSL.dbf in SALES.dbf
(f)
(i)
(ii)
(iii)

Write Foxpro commands for the following:
To list all the records where BDATE is 23/12/47.
To add one record between 8th and 9th record in a file called PAYROLL.
To replace field CITY in all records with MUMBAI whenever it contains
BOMBAY.

Q8 (a) Explain any two options from the Start Menu in Windows’95.
(b)

(c)

[3]

[2]

What is the use of VIEW Menu in Ms-Word and discuss any four options
from this menu.

[2]

Currently you are editing a document in Ms-Word. Now you want to enter
the text “HAPPY NEW YEAR 2002” at the top of each page and page no.
at the bottom. Explain how to achieve this.

[2]

(d) Explain the difference between the following in Foxpro:
(i) SET DELETED ON and SET DELETED OFF
(ii) JOIN and UPDATE
(iii)
Single Index and
Index.

[6]
Compound

(e) There is a Foxpro table called EMPL.dbf This file contains fields Employee
no. (EN,N,3) , Name (ENAME,C,20), Basic Pay (BPAY,N,8,2),
Department (DEPT,C,20) and date of payment (PAYDAY,D,8). Another
table called DEDUCT.dbf contains fields Employee No. (EN,N,3),
Provident Fund (PF,N,8,2), Earthquake Relief Fund (EQF,N,8,2), Name of
the month (NM,C,10) and year (YR,N,4,0). Write commands for the
following:
(i) To create compound index files for both the tables according to employee
no.
(ii) To update the table DEDUCT.dbf by computing provident fund @10% of
basic pay, earthquake relief fund as one days basic pay assuming 30
working days, from the table EMPL.dbf

[4]

(iii) List employee no, name, department, date of payment & earthquake relief
fund.
(iv) To create a new table called EMPN.dbf made up of employee no., name,
basic pay, provident fund, month and year.
Q9 (a)
(b)

(c)

What is the Desktop in Windows’95?

[2]

What is the use of FORMAT Menu in Ms-Word and discuss any four
options from this menu.

[2]

Currently you are editing a file in Ms-Word and you have entered five
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questions in 5 different lines. Explain how will you make a table for the
above questions.
(d)

a.
b.
c.

d.

There is a Foxpro table called CURRENT.dbf containing fields account
no.(ACN,N,
10,0),
Customer
Name(NAME,C,20)
and
Balance(BAL,N,12,2). There is another table called TRANS.dbf containing
fields Account no.(ACN,N,10,0), Amount deposited(DEP,N,12,2) and
amount withdrawn(DRAW,N,12,2). Write commands:
To create compound index file for both the tables according to account no.
To list account number, name, amount deposited and amount withdrawn.
To update balance in CURRENT.dbf using amount deposited and amount
withdrawn in TRANS.dbf

[2]

[4]

To create a new table called TEST.dbf containing account number, name,
amount deposited and amount withdrawn.

(e)
(i)
(ii)
(iii)

Write Foxpro commands for the following:
To find the total number of records in current table and store it in JAO.
To find the total of numeric field BONUS and store it in OM.
To make SALARY as 10000 in only those records which are not marked
for deletion.
(iv) To open a table called DISAMT.dbf along with an index file LMN.
(v) To open a table called TUPI.dbf and create a single index file called MNO
based on field NAME.
(vi) To choose work area 1 and open a table called STUDENT.
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MODEL PAPER - 1 SOLUTION
Duration : 2 ½ hours

Marks : 80
SECTION - I (PART - A)

1a (i)
(v)

FALSE
TRUE

(ii)
(vi)

FALSE
FALSE

(iii)
(vii)

FALSE
TRUE

(iv)
(viii)

FALSE
FALSE

1b

Computer memory is also termed as main memory or primary or internal
storage, because it is located within the CPU. Its main function is to store
data, instructions, intermediate and final results. Computers memory has
a limited storage capacity and hence the data that needs to be
immediately processed is loaded in the memory.
RAM and ROM make up the computers memory. Random Access
Memory (RAM) is volatile or temporary whereas Read Only Memory
(ROM) is non-volatile or permanent.

1c (i)

main() is the first function called during program execution. Execution of a
C program begins from this function. Every program should have the
main() function and it should be the first function in a program.
(ii) Automatic, Static, Register and External.
(iii) An escape sequence consists of two characters. The first is a backslash (\)
which is known as escape character. After the backslash appears a single
character which performs a special function. Two examples of escape
sequence characters are :
\n - To move the cursor to the new line.
\t - To move the cursor to the next tab.
(iv) The basic data types in C are :
Integer (int) : these are numbers without the decimal part.
Floating point (float) : these are numbers with or without the decimal part.
Character(char) : these are single characters enclosed in single quotes.
(v) The continue statement will transfer the control to the beginning of the loop.

1d (i)

RIGHT() : This function is used to extract a given number of characters
from the right of a string. e.g. ? RIGHT(“DHARAMVEER”,4) Output :
VEER
(ii) SUBSTR() : This function is used to extract from a specified position of a
string a specific number of characters.
e.g. ? SUBSTR("COMPUTER",4,3)
Output : PUT
(iii) MOD() : This function gives the remainder from a division of two numbers.
e.g. ? MOD(41,13)
Output : 2
(iv) MAX() : This function gives the highest value amongst given values.
e.g. ? MAX(45, 90, 65, 70)
Output: 90
(v) MIN() : This function gives the lowest value amongst given values.
e.g. ? MIN(45, 90, 65, 70)
Output: 45
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2a (i)RAM is used to store the users data, instructions, intermediate and final results.
(ii)The Control Unit of the CPU controls the overall operations of the
computer system.
(iii) The components of LAN are : Server, Workstations, Network Interface
Cards, Cables (i.e. wires), Networking software.
(iv) CPU controls all the activities of the computer system. It receives the data
and instructions from the input devices, temporarily store them, execute
the instructions, perform arithmetic and logical operations, control the
movement of data and send the results to the output devices.
(v) Unix is a multi-user operating system. It is also capable of multi-tasking.
(vi) Advantages of LAN are: Peripherals and software can be shared by everybody,
Users/workstations can easily communicate with each other.
2b

Output :
+006589b+08889.0bbb*
+6589bbbb+8889b*bb

2c

#include<stdio.h>
#include<math.h>
main()
{ float i=1, s=0;
do
{
s = s + pow(i,3)/(i+1);
i++; }
while(i<=9);
printf("SUM = %f\n", s); }

2d

#include<stdio.h>
main()
{ float y, c, r, d;
printf("ENTER
THE
COST
OF
ASSET
DEPRECIATION");
scanf("%f %f", &c, &r);
printf("YEAR\tDEPRECIATION\n");
for (y=1; y<=10; y++)
{ d = c * r/100;
printf("%.0f\t%.2f\n", y, d);
c = c - d; }
printf("SCRAP VALUE = %.2f\n", c); }

3a (i)
a.
b.
c.
d.

(b denotes blank space)

AND

RATE

OF

C.P.U. : Central Processing Unit is like the brain of the computer system. It
is here that the actual processing takes place. Its functions are :
To receive data and instructions from the input devices.
To temporarily store the data and instructions.
To execute (carry out) the users instructions.
To perform arithmetical and logical operations on the data according to the
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e.

a.
b.
c.

(ii)

users instructions.
To control the movement of data and send the results to the output
devices.
The CPU has three components :
Control Unit : It controls overall operations of the computer system.
Arithmetic and Logic Unit (ALU) : All calculations and comparisons i.e.
decision making operations are made in the ALU.
Primary Storage (Main Memory) : Its function is to store data, instructions,
intermediate and final results temporarily.
Windows Operating System : Windows is the most popular operating
system used today. Windows provides a user friendly graphical
environment. It’s menus, icons and dialog boxes replaced commands that
older operating systems required. Windows made computers easier to
learn and use. It allows several applications (programs) to run at the same
time called multi-tasking. It also provides a simple method of exchanging
information between applications. It works only on Microcomputers.

(iii) WAN : WAN means Wide Area Network, where computers which are far
off from each other can exchange data and communicate using telephone
lines and satellites. e.g. computers connected across different cities,
states or countries.
3b (i)

Type modifiers change the meaning of basic data type, to fit the needs of
various situations more precisely. e.g. long, short, signed, unsigned.
(ii) Preprocessor directive is an instruction to the ‘C’ compiler, asking it to
process this statement before compiling the rest of the program. They
should begin with # and should be written before main(). e.g. #include,
#define etc.

3c

Output :
bb13bb
bb28bb
bb314b
bb421b

3d

#include<stdio.h>
#include<math.h>
main()
{ float i, x[10], s1=0, s2=0, s3=0, m, d, md, sd, v;
for (i=0; i<=9; i++)
{ printf("ENTER THE OBSERVATION ");
scanf(“%f”, &x[i]);
s1 = s1 + x[i]; }
m = s1/10;
for (i=0; i<=9; i++)

(b denotes blank space)
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{ d = x[i] - m;
if (d < 0) d = -d;
s2 = s2 + d;
s3 = s3 + d*d; }
md = s2/10;
sd = sqrt(s3/10);
v = sd*sd;
printf(“MEAN = %f\n”, m);
printf("MEAN DEVIATION FROM MEAN = %f\n", md);
printf(“STANDARD DEVIATION = %f\n”, sd);
printf(“VARIANCE = %f\n”, v); }

4a (i)

(ii)

4b (i)

RAM stands for Random Access Memory. It is a temporary/volatile
memory i.e. whatever data or instructions are in RAM would be lost when
the computer is switched off. The information stored in the RAM could be
read, written, modified or erased. RAM stores the users data, instructions,
intermediate and final results.
ROM : ROM stands for Read Only Memory. It is a permanent/non-volatile
memory i.e. the contents of ROM would not be lost when the computer is
switched off. The contents of ROM could only be read, they could not be
modified or erased. Within the ROM the manufacturer stores a program
needed by the computer.
DOS : It is a single-user operating system. It is capable of performing only
one task at a time. It works only on Microcomputers.
UNIX : It is a multi-user operating system. It is also capable of
multi-tasking. It works on Mainframe and Microcomputers.
printf() : This function can be used to print integer, floating point, character
and string constants. It does not cause a line feed (\n) by default.
puts() : This function is used to print a string constant only. It causes a line
feed (\n) by default.

(ii)

scanf() : This function is used to input integer, floating point, character and
string constants from the keyboard. The string should not contain blank
spaces.
gets() : This function is used to input only a string constant from the keyboard.
The string can contain blank spaces.
(iii) putchar() : This function is used to print a character constant only. It does
not cause a line feed (\n) by default.
puts() : This function is used to print a string constant only. It causes a line
feed (\n) by default.
(iv) while () loop : In case of while() loop the condition specified is checked first.
If the condition is satisfied, the statements within the loop are executed.
This continues till the condition is not satisfied, at which point the loop is
terminated.
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do while() loop : In case of do while() loop, the statements within the loop
are executed first and then the condition is checked. If the condition is
satisfied loop is executed once again. The loop terminates when condition
is not satisfied.
4c

Output :
4b22b34

4d

#include<stdio.h>
main()
{
char cn[10];
float a, d, n;
printf("ENTER THE CUSTOMER NAME AND ORDER AMOUNT ");
scanf(“%s %f”, cn, &a);
if (a <= 10000)
d = a*0.05;
else if (a > 10000 && a <= 20000)
d = a*0.10;
else
d = a*0.15;
n = a - d;
printf("CUSTOMER NAME = %s\n", cn);
printf("ORDER AMOUNT = %.2f\n", a);
printf("DISCOUNT = %.2f\n", d);
printf("NET AMOUNT = %.2f\n", n);
}

5a (i)

Unix : Unix is another operating system popular with Mainframe and
Microcomputers. Unix was the first operating system developed keeping in
mind the fact that operating system should be independent of hardware
architecture, thus Unix can work on different computers. Some other
features of Unix are:
It is a multi-user operating system.
It is also capable of multi-tasking.
It allows users/workstations to communicate with each other.
It allows us to create files and directories.

a.
b.
c.
d.

(b denotes blank space)

(ii) LAN : LAN means Local Area Network, where computers located at a
short distance can exchange data and communicate. e.g. computers
connected within an office or a building.
The components of LAN are :
Server, Workstations, Network Interface Cards, Cables (i.e. wires) and
Networking software.
Advantages of LAN are :
a. Peripherals and software can be shared by everybody.
b. Users/workstations can easily communicate with each other.
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(iii) Operating System : Operating System is the most vital software required
to run a computer system. The most important function of the operating
system is to start the computer. The computer is basically a dumb
machine. It is the OS which brings the computer from a “dumb” to an
“intelligent” state i.e. ready to act according to the users instructions. Thus
without the OS a computer cannot work. It is also the most important link
between the user and the computer hardware. Examples of OS are :
MS-DOS, Windows, Unix etc.
5b (i)

(ii)

scanf() : This function is used to input integer, floating point, character and
string constants from the keyboard. The string should not contain blank
spaces.
getchar() : This function is used to input only a character constant from the
keyboard.
getche() : This function is used to input only a character constant. The
input character will appear on the screen but the function will not wait for
the user to press Enter.
getch() : This function is used to input only a character constant. The input
character will not appear on the screen and the function will not wait for
the user to press Enter. Generally, it is also used to temporarily stop the
program execution.

5c

Output :
00013bb+3021bbb

5d

#include<stdio.h>
main()
{ float x[20], i, j, t, m;
for (i=0; i<=19; i++)
{
printf(“ENTER THE OBSERVATION “);
scanf(“%f”, &x[i]);
}
for (i=0; i<=18; i++)
{
for (j=i+1; j<=19; j++)
{
if (x[i] > x[j])
{
t = x[i];
x[i] = x[j];
x[j] = t;
}
}

(b denotes blank space)
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}
printf(“LIST IN ASCENDING ORDER\n”);
for (i=0; i<=19; i++)
{
printf(“%16.2f”, x[i]);
}
printf(“\nLIST IN DESCENDING ORDER\n”);
for (i=19; i>=0; i--)
{
printf(“%8.2f”, x[i]);
}
printf(“\nHIGHEST = %.2f\n”, x[19]);
printf(“LOWEST = %.2f\n”, x[0]);
m = (x[9]+x[10])/2;
printf(“MEDIAN = %.2f\n”, m);
}

SECTION - II

6a

Screen-saver is a Windows feature in which if we leave the keyboard or
mouse idle for some time, animated objects and text will appear on the
screen repeatedly. There are different types of screen-savers like Flying
windows, Scrolling Marquee, Star field simulation, Mystify, Flying objects
etc.

6b

Page setup is used to change default settings of a document i.e. margins,
paper size, header and footer area etc.

6c (i)

FALSE

6d (i)

LIST : The purpose of LIST command is to display all the records.
DISPLAY : The purpose of DISPLAY command is to display the record on
which the record pointer is positioned.
FIND : In case of FIND command character type data should not be
enclosed in quotation marks. If we want to search the data stored in a
memory variable, the memory variable will precede with the ampersand
sign (&).
SEEK : In case of SEEK command character type data should be
enclosed in quotation marks. If we want to search the data stored in a
memory variable, the command will be followed by just the memory
variable name.

(ii)

(ii)

FALSE

(iii)

6e (i) LOCATE FOR "PARSHU" $ NAME
(ii) MODIFY STRUCTURE
(iii) LIST FOR "PATIL" $ NAME
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(iv) GO 10
DELETE NEXT 26
(v) RECALL ALL
(vi) SET DELETED ON
7a

Icons in Windows’95 are pictures that represent applications available
within the computer. It represents different programs, which can be
started by double clicking the left mouse button.

7b

Edit Menu is used to copy, move or delete selected text. It can be used to
undo or redo a particular action, find and replace desired text. It is
activated in following ways :
Move the mouse pointer on the Edit menu and click the left mouse button.
OR
Press Alt+ E keys.
Options from this menu are :
Cut : It is used to cut the selected text and keep it in the memory.
Copy : It is used to copy the selected text into the memory.
Paste : It is used to paste the cut or copied text which is stored in the
memory at the desired location.
Find : It is used to find the desired text in a document.
Replace : It is used to replace the occurrences of the text searched.
Undo : It is used to cancel the last action.
Redo : It is used to repeat the last action.

a.
b.
a.
b.
c.
d.
e.
f.
g.
7c

Follow these steps to do the needful:
To bring the cursor at the beginning of page 3- Select Edit Menu - Select
Go To.
b. We will now get Find and Replace dialog box. Select Page - type 3 as
page no.
c. Select Go To. Select Close to return back to the document.
d. Type AROUND THE WORLD and press Enter key.
e. To replace the word WORLD with GLOBE - Bring the cursor to the
beginning of the the document.
f.
Select Edit Menu - Select Find. We will now get the Find and Replace
dialog box.
a.

g.
h.
i.

Enter the text to be searched - WORLD.
To replace - select Replace button. Type the new text - GLOBE.
And, then select Replace All button to replace all occurrences of the text
searched.

7d (i)

BROWSE : This command is used for global editing of records. It will
display many records on the screen one below the other and allow us to
make changes in them.
PACK : This command is used to remove permanently from the file those

(ii)
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records which were earlier marked for deletion using DELETE command.
(iii) RECALL : This command is used to undelete the records. It removes the *
marking placed before the record by the DELETE command.
7e a.

b.
c.
d.

SELECT A
USE SALES
INDEX ON SNO TAG S_SNO
SELECT B
USE DAILYSL
INDEX ON SNO TAG D_SNO
SELECT A
SET RELATION TO SNO INTO B
LIST SNO, SNAME, B.SDATE, B.SORD, ACOD
UPDATE ON SNO FROM DAILYSL REPLACE TSALES WITH TSALES + B.SORD

7f (i)

SET DATE BRITISH
LIST FOR BDATE = {23/12/47}
(ii) USE PAYROLL
OR
USE PAYROLL
GO 8
GO 9
INSERT
INSERT BEFORE
(iii) REPLACE CITY WITH “MUMBAI” FOR CITY = “BOMBAY”

8a
a.
b.
c.
d.
8b

a.
b.
a.
b.
c.
d.

e.

Some of the options from the Start Menu are :
Programs : It is used to start an application. Move the mouse pointer on
the specified application and click the left mouse button.
Documents : It displays a list of the last 15 documents which are opened
directly from windows and not from any application.
Find : It is used to locate files, folders or other computers on the network.
Shut Down : It is used to safely shut down the computer.
View menu contains options used to display the document in various ways.
It is also used to turn on/off the display of rulers, toolbars. It is also used to
Zoom the page size. It is activated in following ways :
Move the mouse pointer on the View menu and click the left mouse button.
OR
Press Alt+ V keys.
Options from this menu are :
Page Layout : It displays the document as it will look like after printing. It
previews the text and graphic effects.
Ruler : It is used to turn on/off the display of horizontal and vertical rulers.
Toolbars : It is used to turn on/off the display of different toolbars.
Full Screen : It displays only the document and a Full Screen Button in
lower-right corner of the screen. It removes menus, toolbars, scrollbars etc.
from the screen.
Header and Footer : It is used to display repetitive information on the
document’s top and bottom margins respectively.
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8c
a.
b.
c.
d.
e.

Follow these steps to do the needful :
Select View menu - Select Header and Footer.
We will now get header area enabled with Header and Footer Toolbar.
Type HAPPY NEW YEAR 2002. Select Switch between Header and
Footer icon on Header and Footer Toolbar.
We will now get footer area enabled. Select Insert Page number icon on
Header and Footer Toolbar.
And, then Select Close icon on Header and Footer Toolbar to return back
to the document.

8d (i)

SET DELETED ON: This command will ignore all the records marked for
deletion i.e. not allow them to participate in listings and calculations.
SET DELETED OFF: This command will allow the records marked for
deletion to participate in listings and calculations.
(ii) JOIN: This command is used to combine the fields from two databases
and form a new database.
UPDATE: This command is used to update fields in the current database
with data from another database.
(iii) Single Index: It contains only one index key field. The file gets
extension .idx.
Compound Index: It contains many index key fields. The file gets
extension .cdx.

8e (i)

SELECT A
USE EMPL
INDEX ON EN TAG E_EN
SELECT B
USE DEDUCT
INDEX ON EN TAG D_EN
(ii) UPDATE ON EN FROM EMPL REPLACE PF WITH A.BPAY*0.10, EQF WITH
A.BPAY/30
(iii) SELECT A
SET RELATION TO EN INTO B
LIST EN, ENAME, PAYDAY, B.EQF
(iv) JOIN WITH DEDUCT TO EMPN FOR EN = B.EN FIELDS EN, ENAME,
BPAY,
B.PF, B.NM, B.YR

9a

The initial Windows’95 screen is called as Desktop. It contains few icons,
representing the applications available within the computer. The
appearance of the Desktop can be changed according to user’s needs.
This includes change of colours, wall-papers, screen-savers etc.

9b

Format menu contains options used to make the text attractive in
appearance. It allows us to change fonts, character types (Bold, Italic,
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a.
b.
a.
b.
c.
d.

9c
a.
b.
c.
d.
e.

9d a.

b.

c.

d.

underline), add features like subscript, superscript etc. It also provides
different symbols to be used in bulleted and numbered lists. It is activated
in the following ways :
Move mouse pointer on Format menu and click the left mouse button. OR
Press Alt+ O keys.
Options from this menu are :
Font : It is used to change the font, it’s size etc.
Paragraph : It is used to format paragraphs. It allows us to change the text
alignment, line spacing, indent levels, paragraph spacing etc.
Bullets and Numbering : It is used to number the paragraphs or display
bullets.
Borders and Shading : It is used to apply borders and shading to the
selected text.
Follow these steps to do the needful:
Select the text (5 questions).
Select Table menu - Select Convert Text to Table.
We will now get Convert Text to Table dialog box.
Enter the details regarding number of columns, column width etc.
And, then select OK.

SELECT A
USE CURRENT
INDEX ON ACN TAG C_ACN
SELECT B
USE TRANS
INDEX ON ACN TAG T_ACN
SELECT A
SET RELATION TO ACN INTO B
LIST ACN, NAME, B.DEP, B.DRAW
UPDATE ON ACN FROM TRANS REPLACE BAL WITH BAL + B.DEP B.DRAW
JOIN WITH TRANS TO TEST FOR ACN = B.ACN FIELDS ACN, NAME,
B.DEP, B.DRAW

9e (i)
(ii)
(iii)
(iv)
(v)

COUNT TO JAO
SUM BONUS TO OM
REPLACE SALARY WITH 10000 FOR NOT DELETED()
USE DISAMT INDEX LMN
USE TUPI
INDEX ON NAME TO MNO
(vi) SELECT 1
OR SELECT A
USE STUDENT
USE STUDENT
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